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Joint Institute of Mechanical Engineering of
National Academy of Sciences of Belarus

Software ECBus v4.0
Calculation of energy consumption by an electric and diesel buses on the route

ECBus v 4.0.exe

1 Introduction

The software ECBus v 4.0 is designed to calculate the energy consumption of electric
and diesel buses on the route.

ECBus v 4.0 is also used to estimate energy and fuel consumption as well as pollutant
emissions of a diesel bus.

Even if the user does not specify the corresponding data for the electric or diesel bus,
the calculation is performed with the data specified in the program by default.

ECBus v 4.0 can be used to evaluate the following parameters:

1. Energy consumption of the electric and diesel bus on the route
for electric buses
2. Electric energy costs per day, month, year
3. Bus battery capacity for a specific set of routes
4. Distance that a bus with a known battery capacity can travel by a given route af-
ter charging (to determine the location for the next charger)
for diesel buses
5. Fuel consumption
6. Pollutant emissions

Note. In the European Union, emissions of nitrogen oxides (NOx), total hydrocarbon
(THC), non-methane hydrocarbons (NMHC), carbon monoxide (CO) and particulate
matter (PM) are regulated for most vehicle types, including cars, trucks (lorries), loco-
motives, tractors and similar machinery, barges, but excluding seagoing ships and air-
planes. For each vehicle type, different standards apply. Emissions data for heavy-
duty diesel engines of lorries and buses are presented in Table 1. This table is used to
estimate emissions depending on the energy consumption of a bus diesel engine on a
route.

Table 1 Emission standards for heavy-duty diesel engines of lorries and buses, g/kWh
(based on European emission standards: https://en.wikipedia.org/wiki/European_emis-
sion_standards)

Standard Car_bon mon- Hydrocarbons Nitrogen ox- | Particulate mat-
oxide (CO) (HC) ides (NOx) ter (PM)
Euro | 4.5 1.1 8.0 0.36
Euro Il 4.0 1.1 7.0 0.15




Euro 11l 2.1 0.66 5.0 0.1
Euro IV 15 0.46 3.5 0.02
Euro V 15 0.46 2.0 0.02
Euro VI 15 0.13 0.4 0.01

Approach peculiarities. The ECBus v 4.0 program has the following features in calcu-
lating energy consumption during bus movement [1].

1. The speed profile is described with horizontal and inclined lines (sections). The bus
movement is considered as a set of elementary modes with constant accelerations
during time interval (t;, ti+1) for each section.

When moving with constant acceleration / deceleration, the work of the air resistance
forces can be determined using the equivalent resistance force for the considered sec-
tion of the speed profile. So, all the forces are simple to calculate and determine the
traction force Fe. In this case, the energy for each section of the velocity profile is cal-
culated as: Energy=Work=Force ¢ Distance.

2. When using any numerical methods, the calculation is reduced to the consideration
of time periods for which it is assumed that the accelerations for them are constant. In
this case, a situation may arise when at the boundary points of the time interval ti and
ti+1 the values of the traction force Fe have different signs. This situation is especially
relevant when the speed profile is schematized by sufficiently long sections of traffic
with constant acceleration. What is why, the program includes a special procedure that
control the sign of traction force.

3. In addition, a simple calculation of the traction force and the determination of its sign
allow you to set the type of mode: traction or recuperative. This is important for properly
accounting for the recovered energy.

2 System requirements of the ECBus

The program components of ECBus+ are developed in the integrated environment of
Microsoft Visual Studio 2012 based on NET.Framework 4.5, the programming lan-
guage is C #, the application type is Windows Application.

Input files must be created in Microsoft Excel, and have the extension “*.xIs”.
3 Objective of the ECBus

Objective of ECBus v 4.0 is calculate the energy consumption for a bus on a
route when a speed profile, bus data and road data are given. Some additional
results are provided: graphs of energy consumption and traction over time, as
well as distribution of bus speeds and accelerations.

4 Input data for the software ECBus

The input to the program are:

— Calculation identifier,;

— Route description (Infrastructure):
- Identifier of the route in question;
- Route length, m;



- Number N of route segments;
- Segments lengths, m (Segment numbers and Segment lengths);

- Altitudes at the stopping points, m (Stopping points and Altitudes at the stop-
ping points);

— Bus data:
- Identifier of the bus in question;
- Bus weight without passengers, kg;
- Max number of passengers;
- One passenger weight, kg (default is 70 kg);
- Cross section area, m? (default is 6.6 m?);
- Coefficient of air resistance, Ns?/m* (default is 0.4 Ns?/m%);
- Rotation inertia factor (default is 1.05);

- Rolling resistance (for planned types of bus tires and road surfaces) (default
is 0.008 in summer);

- Maximum electrical power of auxiliary system or its subsystems with battery
energy consumption, kW;

- Average efficiency of the invertor (default is 0.98);

- Average efficiency of the motor (default is 0.95);

- Average efficiency of the transmission (default is 0.95);
- Regeneration (recuperation) factor (default is 0.6);

- Effective efficiency of the diesel (default is 0.33);

- Transmission efficiency (default is 0.90);

- Coefficient taking into account the diesel power consumption for equipment
drive (by default 1.05);

- Calorific value of diesel fuel, MJ/I (default is 43.12 MJ/I);

- Diesel emission standard, EURO;
— Trip data:

- Identifier of the trip in question;

- Passenger loads by segments (Segment numbers and % of passenger load
per segment);
— Fuel consumption and Ecology;
— Profile speed.

5 The core of the ECBus
Start

After starting the program ECBus v 4.0, the tab “Source information” opens (Figure 1).



l| File Help

Filename:

Solrce information | Speed profile |

| | 1. Road data
Identifier of the route in question

| Route length, m

Number N of route segments :

Segments lengths, m

|
I Altitudes at the stopping points, m
i
i
W | 2 Busdata
i Identifier of the bus in question Electric
I Bus weight without passengers, kg ] Average efficiency of the invertor (default is 0.98)
| Max number of passengers Average efficiency of the motor (default is 0.95)
One passenger weight, kg (default is 70 kg) Average efficiency of the transmission (default is 0.95)
Cross section area (default is 6.6 m2) Regeneration (recuperation) factor (default is 0.6)
I Coefficient of air resistance (default is 0.4 Ns2/m4) Maximum electrical power of auxiliary system or its subsystems with battery energy consumption, KW
I Rotation inertia factor (default is 1.05) Diesel
| Rolling resistance (for planned types of bus tires and road surfaces) Effective efficiency of the diesel (default is 0.33)
| (defaultis 0.008 in summer) Transmission efficiency (default is 0,90)
: Coefficient taking into account the diesel power consumption for equipment drive (by default 1.05)
Calorific value of diesel fuel, MJ/l (default is 43.12 MJ/)
I Diesel emission standard, EURO (default 5)
3. Trip data
I Identifier of the trip in question

Passenger loads % by segments

Bus weight calculation type
@ Fixed weight © Depends on workload

Save edit

Figure 1 Window after starting the program

Download data on the road, bus and route

To download the data on the road, bus and route it is necessary to press “File” ->
“Open” (Figure 2). In the window that appears, select the file and press “Open” (Fig-
ure 3).

Downloadable Excel-file with the extension *.xls, must be filled in according to the tem-
plate, an example of which is shown in Figures 4-7.



File | Help

Open

Open file containing speed profile

1. Road data
Identifier of the route in question

Route length, m

Number N of route segments :

Segments lengths, m

Altitudes at the stopping points, m

2. Bus data

Identifier of the bus in question

Bus weight without passengers, kg

Max number of passengers

One passenger weight, kg (defaultis 70 kg)

Cross section area (default is 6.6 m2)

Coefficient of air resistance (default is 0.4 Ns2/m4)
Rotation inertia factor (default is 1.05)

Rolling resistance (for planned types of bus tires and road surfaces)
(default is 0.008 in summer)

3. Trip data

Identifier of the trip in question

Passenger loads % by segments

Bus weight calculation type

@ Fixed weight © Depends on workload

Electric

Average efficiency of the invertor (default is 0.98)
Average efficiency of the motor (default is 0.95)

A ge efficiency of the

(default is 0.95)

Regeneration (recuperation) factor (default is 0.6)

Mandmum electrical power of auxliary system or its subsystems with battery energy consumption, kW
Diesel

Effective efficiency of the diesel (default is 0.33)

Transmission efficiency (default is 0,90)

Coefficient taking into account the diesel power consumption for equipment drive (by default 1.05)

Calorific value of diesel fuel, MJ/1 (default is 43.12 MJ/T)

Diesel emission standard, EURQ (default 5)

Save edit

Figure 2 Opening the program file




File

Filename:

Help

Source information | Speed profile

1. Road data

Identifier of the route in question

Identifier of the trip in question

Passenger loads % by segments

Bus weight calculation type

@ Fixed weight © Depends on workload

Rout| & Bobepure foxyment ars sarpyscy asrrsi ==
Numl -@@ﬂ‘ | b Kownstotep b Hosoiii Tom (D:) b ERA-NET » test program DelG » - [ | [ Moues: test program Del 3
Ynopsaounte ¥ Hoean nanka
Segl| g 3arpyzau = Wwa : Iomawmenerw | Tan Pasmep
P Pabounii cron
b fast 11.06.202013:50 Manka c gaitnanu
1% ADASHKEVICH-F
). medium 11.06.2020 14:14 Manka ¢ daiinanu
Altity T ALGIN
- Goman b slow 11.06.2020 14:17 Manka c daiinanau
“E‘ N fast-profileads 11.06.2020 11:18 finer Microsoft Ex... 34 KB
! | fast-routexis 11.06.2020 14:19 Nnet Microsoft Ex... 41KB
2 Busd| 1 SKOROHODOV
- i fioad B9 medium-profilexls 11.06.2020 9:57 Tnet Microsoft Ex... EETS
| public floa
Ident| El:” . medium-routeads 110620201420 Ancr Microsoft Ex... 41KB
Bus || ZoRpamkEa slow-profilexls 11.06.2020 9:48 fiwer Microsoft Ex... 37KB
P | — B slow-routexis 11.06.2020 14:20 Tlner Microsoft Ex... 41KB
wbuoTekn
onel| B Braeo
[3 Aorymener
Cros{| &) Msobpaxenna
Coeffl| @ My=ica
Rotalll & Kouneiarep i
Rollif)| B
Vs daiina: fast-routexds ~ | Excel 2003(*xis) -
Cal value ef s
Diesel emission standard, EURO (default 5)
3. Trip data

drive (by default 1.05)

I lenergy consumption, kW

Save edit

Figure 3 Selecting an openable file with a description of the road, bus and route

Figure 4 An example of filling out the “Route description” template

4 A | B | ¢ | b | E | F 6 | w | v | v |k | L | ™M | N | 0o |
1 | Calculation identifier 1

2

3 |1. Route description (Infrastructure)

. |Road data

5 |ldentifier of the route in question 1

6 |Route lengih, m 8232,5]

7 |Number N of route segments 13

5 | Segments lengths

o |Segment numbers 1, 2 | 1] 2] 3] | 5] 6] 7] 8] [ 10] 1] 12] 13]

10 [Segment lengths s(1). 5(2).__s(N). m | 1005.8] 5155| 1034.7] 667.7] 522.8] 4832 1206 3561 561.5] 4342] 866.7] 608.3] 956.4|

1, |Altitudes at the stopping points

12 |Stopping points 1.2, N+1 | 1] 2] 3] | 5] 6] 7] 8] 9 10] 1] 12] 13] 14]
13 |Altitudes at the stopping points h(1), h(2),....h(N+1), m | 224 223 222] 212] 210] 98] 194] 193] 109 206] 211[ 211] 222 224
14




A B C
15| 2. Bus data

16 Identifier of the bus in question 1
17 |Bus weight without passengers, kg 15000
18 Max number of passengers 80
13 One passenger weight, kg (default is 70 kqg) 70
20 Cross section area (default is 6.6 mz} 6.6
21 | Coefficient of air resistance (default is 0.4 Ns“m*) 0.4
22 Rotation inertia factor (default is 1.05) 1,05
Rolling resistance (for planned types of bus tires and
23 road surfaces) (default is 0 008 in summer) 0.012
L} Electric
Maximum electrical power of auxiliary system or its
25 subsystems with battery energy consumption, kKW 0
25 Average efficiency of the inverior (default is 0.98) 0,08
27 Average efiiciency of the motor (default is 0.95) 0,95
- Average efficiency of the transmission (default is 0.95) 105
20 Regeneration (recuperation) factor (default is 0.6) 0.85
30 Diesel
31 Effective efficiency of the diesel (default is 0,33) 0.33
32 Transmission efficiency (default is 0,90) 09
Coefficient taking into account the diesel power
33 consumption for equipment drive (by default 1.05) 1,05
34 Calorific value of diesel fuel, MJ/I (default is 43.12 MJ/) 43,12
35 Diesel emission standard, EURO 4

Figure 5 An example of filling out the “Bus data” template

s57|3. Trip data
3g |ldentifier of the trip in question | 1 |

10 | Passenger loads by segments

40 [Segment numbers 1.2, . N [ 1] 2 3] 4] 5] 6] 7] 8] o] 10] 1] 12] 13|
11 [% of passenger load per segment [ 100] 50 25] 0] 30] 80] 20] 40] 90] 75] 60] 30]  100]

Figure 6 An example of filling out the “Trip data” template

A B C D E
23 |4. Fuel consumption and Ecology
Nitroge | Particul
Hydroc
Carbon n ate
Standard monoxid a;gc&qs oxides | matter
a1 e (CO) (NOL) | (PM)
a5 Euro | 4.5 1.1 8 0,36
46 Euroll 4 1.1 7 0.15
a7 Euro Il 21 0,66 5 0,1
a3 Euro IV 1.5 0,46 3.5 0,02
a9 Euro V 1.5 0,46 2 0,02
50 Euro VI 15 0,13 0.4 0.01
c1

Figure 7 An example of filling out the “Fuel consumption and Ecology” template

The first section “Trip data” must be filled in the downloaded file, other values can be
accepted by default.

Figure 8 shows the result of loading data from the file.



File Help

Fiename: DAERANET\unn Tecra aHepr saTpar o Mapupymy\est_program_ECBus_v4.0xds

Solrce information | Speed profile |

1. Road data
Identifier of the route in question 1
Route length, m 82325

Number N of route segments |13

1 2 3 4 5 6 7 8 9 10
Segments lengths, m R 5 5.5 1034.7 6677 522.8 4832 129.6 3561 5615 4342
« v
1 2 4 5 6 7 8 9 10 11
Altitudes at the stapping points, m 223 222 212 210 198 194 193 199 206 211
< [ 0
2 Bus data
Identifier of the bus in question 1 Electric
Bus weight without passengers, kg 15000 Average efficiency of the invertor (default is 0.98) 0.98
Max number of passengers 30 Average efficiency of the motor (default is 0.95) 0.95
One passenger weight, kg (default is 70 kg) 70 Average efficiency of the transmission (default is 0.95) 095
Cross section area (defaultis 6.6 m2) 56 Regeneration (recuperation) factor (default is 0.6) 0.85
Cosfficient of air resistance (default is 0.4 Ns2/md) 0.4 Maximum electrical power of awsiliary system or its subsystems with battery energy consumption. kW 0
Rotation inertia factor (defaultis 1.05) 1.05 Diesel
Rolling resistance (for planned types of bus tires and road surfaces) Effective efficiency of the diesel (defaultis 0.33) 033
(default is 0.008 in summer) 0.012 Transmission efficiency (default is 0,90) 0.9
Coefficient taking into account the diesel power consumption for equipment drive (by default 1.05) 1.05
Calarific value of diesel fuel, MJ/I (default is 43.12 MJ/1) 43,12
Diesel emission standard, EURO (default 5) 4
3. Trip data
Identifier of the trip in question
Passenger loads % by segments 1 2 3 4 5 6 7 8 9 10 1

oo N 25 40 30 80 20 40 20 75 60
<[ nr.

Bus weight calculation type

@ Fixed weight © Depends on workload

Save edit

Figure 8 Downloaded data

If there is a need to make changes to the data displayed in Figure 8, you must perform
the following steps:

1) edit the necessary data;
2) click the “Save edit” button.

After that, updated data will be used for calculation, which will also be saved in the file.
Downloading a file containing a speed profile

To download a file containing a speed profile, click “File” -> “Open file contain-
ing speed profile” (Figure 9), then select the required file and click “Open” (Figure 10).

A file containing data describing the speed profile must be created in Excel and have
the extension *.xIs. Figure 11 shows an example of filling a file with a speed profile:
values of time (s), and speeds (km per hour), corresponding to time values.



Help

Open test_program_ECBus_v4.0xs

Open file containing speed profile

1. Road data
Identifier of the route in question 1

Route length, m 82325

Number N of route segments

1 2 4 5 6 7 8 9 10
Segments lengths, m 515.5 |867.7 |s22.8 [483.2 [120.8 |as8,1 |561,5 |434,2 |
“ m ] r
1 2 4 5 6 7 8 9 10 11
Altitudes at the stopping paints, m 223 [222 [212 [210 [198 [194 [193 [199 |206 [211
< m ] +
2 Bus data
Identifier of the bus in question 1 Electric
Bus weight without passengers, kg 15000 Average efficiency of the invertor (default is 0.98) 098
Max number of passengers 80 Average efficiency of the motor (default is 0.95) 0.95
One passenger weight, kg (default is 70 kg) 70 Average efficiency of the transmission (default is 0.95) 0.95
Cross section area (default is 6.6 m2) 66 Regeneration (recuperation) factor (default is 0.6) 0.85
Coefficient of air resistance (default is 0.4 Ns2/m4) 0.4 Maximum electrical power of auxliary system or its subsystems with battery energy consumption, kW 0
Rotation inertia factor (default is 1.05) 1.05 Diesel
Rolling resistance (for planned types of bus tires and road surfaces) Effective efficiency of the diesel (defaultis 0.33) 033
(default is 0.008 in summer) 0.012 Transmission efficiency (default is 0,90) 0.8
Coefficient taking into account the diesel power consumption for equipment drive (by default 1.05) 1.05
Calorific value of diesel fuel, MJ/l (default is 43.12 MJ/l)  43.12
Diesel emission standard, EURO (default 5) 4
3. Trip data
Identifier of the trip in question 1
Passenger loads % by segments 1 2 4 5 8 g 10 1
50 40 30 80 20 40 ‘ 90 75 6
) m J +
Bus weight calculation type
Fixed weight © Depends on workload
Save edit

Figure 9 Opening the file with the speed profile using the menu
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File Help
Flename: D'\ERA-HET\17R 78678 SHEPT STET Mo MapUpYTy tast_program_ECBuUs_v Dxds
Source information | Speed profile
1. Road data
Identifier of the route in question 1
Route length, m 82325
Number N of route segments |13
[ 2 3 4 5 6 7 a 9 10
-
Segments lengths, m < BuifiepiTe IOKyMEHT J1R 3arpy3KiA AaHHbIX — - - - - - = |434,2 |
sl » Komnsrorep b Hoseiii om (D:) » ERA-NET » gna Tecta sHepr sapat no Mapuipyty » v | #2 | Moucx: 2= mecma awepz sam... P r
U oy =
| Altitudes at the stopping Ynopagon. = Hosas nanka . -0 @ 206 ‘211
& 3arpyskn 2 Vma Jlata wsmenerns Tun Pasmep ol s
PaGoumii
3 Bue dot : AE;r:JZL 4o W3 0912.201911:00 Manka c daiinann
us data ) . e B 1 21120101248 flact Microsoft Ex.. 276
dentifier of the bus in qu ‘: coMAN B 25 2911.201912:48 Nt Microsoft Ex. 27KB
Bus weight without passef| = B 3x0s 21120191248 Nlncr Micrasoft Ex... E
! 18 ISHIN
Max number of B SXOROHOD0Y B 4 201120191248 fiver Microsoft Ex...
P B 5.5 29.11.201912:48 et Microsoft Ex.
One passenger weight. ki Q :” : o8 & 6xls 201120191248 flacr Microsoft Ex... K6
Cross section area (defad| s %Ix\s 2112001248 Nlact Microsoft Ex.. 276 4
Bals 29.11.201912:49 et Microsoft Bx.. 27KB
Butn Wb kw0
c of air “"E'; voTexn B 9as 201120191249 lacr Microsoft Ex... 27K6
Rotaton inert factor (¢ ;::M:em. & 1045 291120191249 flact Microsoft Ex... 27K6
Aol " . ' W K); @ 11ds 29.11.201912:49 et Microsoft Bx.. 27KB
oling resistance (for pid| % M” — B 125 201120191249 lacr Microsoft Ex... 27K6
(defdl GEE & 135 291120191249 flact Microsoft Ex... 27K6
rofile_speed.xls 11.12.201915:07 et Microsoft Ex.. 33KB
profile_sp 5) 105
18 KomnstoTep i il .
- B temnlate for FCRus vixls 26.02.2020 14:23 Nuaer Micrasaft Fx. 34 KR
Vs paiina: | + [ Excel 2003(°xe) -
3. Trip data ‘
Identifier of the trip in question 1
Passenger loads % by segments 1 2 3 4 5 & 7 8 9 10 1
50 25 40 30 80 20 40 |30 75 60|
< e | D
Bus weight calculation type
@ Fixed weight © Depends on workload
Save edit
1L
Figure 10 Selecting a file containing a speed profile
A | B | <
1|ts v, km/h
2 0,00 0.0
3 5,00 21,9
. | 10,30 17,2
3 21,64 42,2
6 42,49 0.0
7 58,42 0.0
2 64,12 20,2
9 69,92 6,3
10 86,49 27,0
11 99,07 8.2
12| 111,56 @ 387 | A | B | Cc |, D | E | F | 6 | H | 1 | 1
13| 12412 86 1|t,s 0,00 5,00 10,30 21,64 42,49 58,42 64,12 69,92
14| 137,85 43,5 2 |v, km/h 0,0 21,9 17,2 42,2 0,0 0,0 20,2 6,3
15 1An a5 A1 9 =

Figure 11 Views of Excel-files with speed profiles: vertical or horizontal tables

Switching the user to the tab “Speed profile”

After loading the speed profile and switching the user to the tab “Speed profile”, a
graphical representation of the speed profile from the downloaded file is displayed on
the tab “Speed profile of the chart” (Figure 12).

11



= ECBusv 40 =TS
|

Bl File Help
Filename: DAERA-NET\1ns TecTa arepr sampar no MapupyTyest_program_ECBus_v4 Oxds

Source information | Speed profile ;|

Filename D:\ERA-NET\ana TecTa 3Hepr 2aTpaT no MapwpyTy\profile_speed xis

Calculate

Chart speed profile |Ca\cu|aled energy costs | Energy graph | Traction Force Graph | Speed range | Acceleration range

ey
# I |

J d L 4 et 1
0 200 400 600 800 1000 1200

. kmhh
5
———
—

Figure 12 Speed profile and its graphical representation

Calculating

Before clicking on the “Calculate” button, it is necessary to select the method of weight
accounting: fixed weight or changing weight on each segment depending on the pas-
senger load (%). A button for the choice of weight is located on the tab “Source infor-
mation”.

To calculate energy costs when driving a bus on the route, you must click “Calculate”.

6 The outputs of the ECBus

After calculating and switching to the tab “Calculated energy costs”, the following data
are displayed: path length, calculated according to the speed profile, energy expended
for movement, recuperated energy, total energy consumption for movement, specific
consumption, energy consumption for heating / cooling the bus compartment and
driver’s cabin, energy costs for heating / cooling and movement, the total energy taking
into account heating / cooling as well as the specific energy consumption in this case,
diesel energy consumption (kWh), fuel consumption (liters per route), fuel consumption
(liters per 100 km), pollutant emission (g) for the route: CO, HC, NOx, PM. The results
of the calculations of these parameters are presented in Figure 13.

12
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File Help
Filename: DAERA-NET\1ns TecTa arepr sampar no MapupyTyest_program_ECBus_v4 Oxds

Sour:emfnrmaunn‘ Speed profile

Filename D:\ERA-NET\ana TecTta aHepr saTpaTt no MapwpyTy\profile_speed xis

I Calculate

Chart speed profile | Calculated energy costs | Energy graph | Traction Force Graph | Speed range | Acceleration range

Movement HVAC and etc. Diessl
Path length, m 7960 Energy spent, kWh 0 Energy consumption, kWh  37.853
Energy consumed, kWh 12,106 Fuel consumption, | 3.2
Total

Energy recuperated, kWh 4.724 Fuel consumption, 1100 km 39.7
Energy consumed, kWh 12,106

Total energy consumption, kWh 7.382

Total energy consumption, kWh  7.382 Ecology for the route, g
Specific energy consumption, kWh/km  0.927
Specific energy consumption, kWhikm 0.927 co 56779
HC 17412
NOx 132484
pm 0757

Figure 13 Results of energy calculations

Energy graphs

After switching to the tab “Energy graph”, the graphs of changes in the consumed,
recovered, total (resulting) energies for electric and diesel energy consumption are
displayed (Figure 14).

File Help
Filename: D\ERANET\ans Tecta sHepr satpat no MapupyTy\est_program_ECBus_vd 0xs

Sourcemfurmauun‘ Speed profile

Filename D\ERA-NET\nna TecTa aHepr 2aTpaT no MaplwpyTy\profile_speed xis

l Calculate:

‘ Chart speed profile | Calculated energy cosis Energy graph || Traction Force Graph | Speedrange | Acceleration range

40 = Energy consumed (electra)
—— Energy recuperated (electra)
Total energy consumplion
(electro)

Diesel energy consumption

£, kitvh

IS

0 200 400 600 200 1000 1200

Figure 14 Graphs of energy changes
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Traction force graph

To view the graph of change in the traction force, you must go to the tab “Traction
Force Graph” (Figure 15).

Fiename: DAERANET\unn Tecra aHepr saTpar o Mapupymy\est_program_ECBus_v4.0xds

Sour:emfnrmaunn‘ Speed profile ‘

Filename D:\ERA-NET\ana TecTa 3Hepr 2aTpaT no MapwpyTy\profile_speed xis

l Calculate

‘ Chart speed profile | Calculated energy costs | Energy graph || I raction Force Graph | Speed range | Acceleration range

Traction force values: from -15698 N to 20885 N

nnnnn

10000 ’7 ’7 =M

-10000

-20000;

Figure 15 Graph of change in traction force

Histogram of the speed distribution

A histogram of the speed distribution is displayed after the switching to the tab «Speed
range» (Figure 16).

14



| File Help |

Fiename: DAERANET\unn Tecra aHepr saTpar o Mapupymy\est_program_ECBus_v4.0xds

Source |n|olmalmn‘ Speed profile ‘

Filename D:\ERA-NET\ana TecTa 3Hepr 2aTpaT no MapwpyTy\profile_speed xis

I l Calculate

‘ Chartspeed profile | Calculated energy costs | Energy graph | Traction Force Graph || Speed range i| A ion range

Speed values: from 0 km/h to 53,8 km/h

0.06

v kmh

Figure 16 Histogram of the speed distribution

Accelerations distribution

After switching to the tab “Acceleration range”, a histogram of the distribution of accel-
erations is displayed (Figure 17).

15



File Help
Filename: DAERA-NET\1ns TecTa arepr sampar no MapupyTyest_program_ECBus_v4 Oxds

Source |niolmalmn‘ Speed profile ‘

Filename D:\ERA-NET\ana TecTa 3Hepr 2aTpaT no MapwpyTy\profile_speed xis

l Calculate

‘ Chartspeed profile | Calculated energy costs | Energy graph | Traction Force Graph | Speed rangs || Acceleration range ||

Acceleration values: from -1,09 m/s"2 to 1,217 m/s"2

012

01

§omis"2

Figure 17 Histogram of the accelerations distribution

7 Information about the organization-developer

After switching “Help” -> “About”, information about the organization-developer of the
program will be displayed (Figure 18).
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File Help
Filename: DAERA-NET\mna TecTa sHepr saTpaT no MapuwpyTy\test_program_ECBus_v4.0xls

‘ Source mfnrmauonl Speed profile |

Filename D\ERA-NET\ans Tecta swepr saTpaT no mapwpyTy\profile_speed xis

[ Calculate ]

Chart speed profile ‘ Calculated energy costs | Energy graph | Traction Force Graph | Speed range | Acceleration vangs‘

60

(3 About = | B ||

State Scientific Institution “The Joint Institute
of Mechanical Engineering

of the National Academy of Sciences of Belarus”
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2020
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Figure 18 Organization-developer
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